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Important notices

Intended use
Pony graphic is an electrical medical device designed to perform

pulmonary function tests.

It is to be used by physicians or by trained personnel on a physi-
cian responsibility.

This equipment has been conceived to be used as an auxiliary
instrument in order to:

• formulate lung pathology diagnosis;

• perform studies concerning human physiology;

• get information in sport medicine.

No responsibility attaches COSMED srl for any accident hap-

pened after wrong use of the device, such as:

• use by non qualified people;

• non respect of the device intended use;

• non respect of all the following precautions and instructions.

Warnings
The device, the programme algorithms and the presentation of
measured data have been developed according to the specifica-

tions of ATS (American Thoracic Society) and ERS (European

Respiratory Society). Other international references have been
followed when these were not available All bibliography refer-

ences are reported in manual Appendix.

The present handbook has been developed following the 93/42

CEE requirements, according to which Pony graphic is to be

considered Class IIa device.

It is recommended to read carefully the following precautions

before putting the device into operation.

The precautions reported below are of fundamental importance to

assure the safety of all COSMED equipment users.

1. This user manual is to be considered as a part of the medical

device and should always be kept on hand.
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2. Safety, measure accuracy and precision can be assured only
if:

· are used the accessories described in the manual or given

with the device. Actually non recommended accessories can
affect safety unfavourable. Before using non recommended

accessories is necessary to get in touch with the manufac-

turer;

· ordinary equipment maintenance, inspections, disinfection

and cleaning are performed in the way and with the frequency
described;

· any modification or fixing is carried out by qualified person-
nel;

· the environmental conditions and the electrical plants where

the device operates are in compliance with the specifications
of the manual and the present regulations concerning electri-

cal plants.

3. This device is not suitable for use in presence of flammable

anesthetics. It is not an AP nor an APG device (according to

the EN 60 601-1 definitions).

4. Keep the device away from heat and flame source, flamma-

ble or inflammable liquids or gases and explosive atmos-

pheres.

5. We recommend to use only the provided battery charger

(P/N C00766-0X-30). Any other charger could damage the
device.

6. According to the intended use of this device, Pony graphic is
not to be used together with other medical devices unless it is

clearly declared by the manufacturer itself.

7. In case the device is to be used with a PC, is recommended to
use a computer with electromagnetic compatibility CE mark-

ing and with low radiation emission displays.

8. It is necessary to make the PC, connected to the Pony

graphic, compliants with EEN 60601-1 by mean of an isolation

trasformer.
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9. Graphical symbols used in accordance to present specifica-
tions are described here below:

Equipment type B (EN60601-1)

Danger: high temperature

OFF

ON

Protective Earth Ground

Alternating Current
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Contraindication
The physical strain to execute the respiratory manoeuvre is con-
traindicated in case of some symptoms or pathology. The follow-

ing list is not complete and must be considered as a piece of mere

information.

Contraindications for the Spirometer tests
Absolute contraindications
For FVC, VC and MVV tests:

• Post-operating state from thoracic surgery

For FVC tests:

• Severe instability of the airways (such as a destructive bron-

chial emphysema)

• Bronchial no-specific marked hypersensitivity

• Serious problems for the gas exchange (total or partial respi-
ratory insufficiency)

Relative contraindications
For FVC tests:

• spontaneous post-pneumothorax state

• arterial-venous aneurysm

• strong arterial hypertension

• pregnancy with complications at the 3 mouth.

For MVV test:

• hyperventilation syndrome

Contraindications for Bronchial provocation tests
The bronchial provocation tests must be executed according to
the doctor’s discretion. There are not data that reveal specific

contraindication for the bronchial provocation test through inha-

lation.
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The modern standard processes have been revealing secure in
several clinical studies. However it is recommendable to respect

the following contraindications:

Absolute contraindications
• Serious bronchial obstruction (FEV1 in adults)

• Recent myocardium infarct

• Recent vascular-cerebral accident

• Known arterial aneurysm

• incapacity for understanding the provocation test procedures

and its implications.

Relative contraindications
• Bronchial obstruction caused by the respiratory manoeuvre.

• Moderate or serious bronchial obstruction. For ex. Predicted
value FEV1 less than 1.51 in men and predicted value FEV1

in women less than 1.21.

• Recent infection in the superior air tracts

• During the asthmatic re- acuting

• Hypertension

• Pregnancy

• A pharmacology treatment epilepsy
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Checking the packing contents
The Pony graphic is composed by a Main unit and by some other

accessories.

Make sure that the packing box contains the instruments listed

below. In case of missing or damaged parts, please contact your
nearest COSMED technical assistance.

Pony Graphic standard equipment
The Pony graphic contains the following instruments:

Description Part number Quantity

Turbine L89 C00292-01-05 1

Optoelectronic reader C00095-01-05 1

Mouthpiece adapter for children C00214-01-20 1

Carrying case C00109-01-30 1

Paper mouthpiece for adults C00136-01-20 50

Paper mouthpiece for children C00137-01-20 50

Nose clips A662100001 2

Roll of paper C00643-01-98 2

Printer ribbon A 666 905 001 2

Power supply 220V 12V 1A C00766-01-30 1

Batteries charger adapter in car C00297-01-12 1

Serial cable RS232 C00150-01-12 1

SW_PC Win Pony Graphic C01335-02-35 1

User manual C00296-02-91 1

Registration card C00067-02-94 1

Turbine attention paper C00169-01-92
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Warranty registration
Before operating the system, please fill in the registration form

and send it to COSMED.

To be registered means being entitled to customer’s assistance.

For further information concerning the benefits, please refer to

the registration form.

Contacting COSMED
For further information you may contact the manufacturer di-

rectly at the following address:

COSMED S.r.l

Via dei Piani di Monte Savello, 37

P.O. Box 3

00040 - Pavona di Albano - Rome Italy

tel: +39-06-93.15.492

fax: +39-06-93.14.580

E-mail: info@cosmed.it

Internet: www.cosmed.it/support

Safety and conformity
Safety
IEC 601-1 (1988)/EN 60 601-1 (1990);

Below is reported the complete classification of the device:

• Class II B device if used with specified power supply or in-

ternally powered equipment class B device if used stand
alone.

• Protection against water penetration: IP00, ordinary equip-

ment unprotected against water penetration

• Non sterile device

• Device not suitable in the presence of flammable anesthetics;

• Continuos functioning equipment;

EMC
The system meets the EMC Directive 89/336

EN 60601-1-2
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EN 55011 Class B (emission)

IEC 1000-4-2 (1991, immunity ESD): 4KV CD, 8 KV AD

IEC 1000-4-3 (1984, immunity fields EM): 3 V/m

IEC 1000-4-4 (1988, immunity Burst): 1 KV

Quality Assurance
UNI ISO EN 9001 (Registration n° 387 Cermet)

Medical Device Directive (CE mark)
MDD  93/42/EEC (Notified Body 0476)

Class IIa.
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Environmental condition of utilization
COSMED units have been conceived for operating in medically
utilized rooms without potential explosion hazards.

The units should not be installed in vicinity of x-ray equipment,
motors or transformers with high installed power rating since

electric or magnetic interferences may falsify the result of meas-

urements or make them impossible. Due to this the vicinity of
power lines is to be avoided as well.

Cosmed equipment are not AP not APG devices (according to

EN 60601-1): they are not suitable for use in presence of flam-
mable anaesthetic mixtures with air, oxygen or nitrogen protox-

ide.

If not otherwise stated in the shipping documents, Cosmed equip-

ment have been conceived for operating under normal environ-

mental temperatures and conditions [IEC 601-1(1988)/EN 60
601-1 (1990)].

• Temperature range 10°C (50°F) and 40°C (104°F).

• Relative humidity range 20% to 80%

• Atmospheric Pressure range 700 to 1060 mBar

• Avoid to use it in presence of noxious fumes or dusty envi-

ronment and near heat sources.

• Do not place near heat sources.

Notice: if  accidentally droppings, exposure to heat source and

excessive humidity may compromise the validity of the system, we

recommend you a calibration check or ask for a technical assist-

ance.
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Conventions
Here are the conventions used for its draft.

Typographic conventions
The following typographic conventions are used in this manual:

Type Represents

Bold It indicates an item  to be selected or a key to be
pressed, in this last opportunity the beginner letter is

always a capital letter.

"italic" It indicates, if it is in inverted commas”, the message

showed on the Pony display.

Graphic conventions
The following Graphic conventions are used in this manual:

Symbol Description

Key It represents the key to be pressed to execute the pre-

dicted function.

Display It represents prompts and messages on the Pony dis-

play during the execution of corresponding functions.
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Features
Pony graphic, which is represented in the figure below, is a spiro-
metric system to evaluate static and dynamic lung functionality.

Pony graphic  allows to download data to a PC through a serial
RS232 connection.

New features
Graphic display
The wide display allows to show in real time the flow/volume
loop during the Forced Vital Capacity manoeuvre and the vol-

ume/time loop during Slow Vital Capacity and Maximum Volun-

tary Ventilation manoeuvre. The back-lighting gives a better
visibility even in conditions of poor lighting.

Keyboard

Graphic  LCD

Printer
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Turbine
Due to new helicoidal conveyers, it offers very low resistance to

the flow (< 0.7 cmH2O/l/s at 12 l/s of flow).

Printer
The new High speed Epson printer (2.5 lin/s). Pony graphic pro-

vides a complete print out report in few seconds. Pony graphic

enables to print a wide print out meeting the ATS 1987 require-
ments through an external printer. This feature is compatible with

printers having HP PCL3 printer language and with a serial port.

Test management
It is possible to display and print out tests stored in the archive

even afterwards.

Bronchial provocation response
With the Pony graphic it is possible to display and print out the

fall of FEV1 at the end of each Post test choosing Fall Fev1

command at the end of every FVC post.

Predicted values
By means of the Predicted command of the Configuration menu

it is possible to select the following predicted values:

Adults Paediatric

ERS 93 Zapletal

ITS ITS

Knudson 83 Knudson83

MC Barcelona MC Barcelona

LAM LAM

Calibration
The calibration process is completely managed by the keyboard.

Automatic diagnosis
The automatic diagnosis can now be enabled or disabled by user.

Supply
The new Ni-Cd batteries (without memory effect) and rapid bat-
teries charger allow to use the Pony graphic even during the bat-

teries charging.
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Accessories
Here following the list of the main accessories consumables for

Pony graphic.

Accessories/consumables
Description Part Number

Calibration syringe (3 litres) C00600-01-11

Paper  mouthpiece for children  (500pcs) C01814-01-98

Paper  mouthpiece for adults  (500pcs) C01805-01-98

Roll  of paper (10pcs) C00643-01-98

Printer  ribbon (5 pcs) A666 905 001

Nose clips (5 pcs) C00441-01-98

Technical Features
Features Value

Flow meter Digital bidirectional turbine

Flow range 0.03 - 20 l/s

Volume range 10 l

Accuracy F/V ± 3% or ± 50 ml

Dynamic res at 12 l/s < 0.7 cm H2O/l/s

Mouthpieces Ø 31 and 22 mm

Graphic display Back lighting LCD 70x80 mm

Printer Graphic, 24 char/lin, 2,5 lines/s

Keyboard 12 multifunction keys

Serial cable RS 232 bidirectional 4800 baud.

Power supply Batteries Ni-Cd 5V, 1,2 Ah

Battery autonomy 200 tests including prints out

Battery charge 12V dc - 1,2 A

Dimensions 237x127x46 mm

Weight 1,2 kg

PC configuration required
• Pentium 133 MMz.

• Windows 95, 98, NT.

• 16 Mb RAM .
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• 3.5 drive.

• VGA, SVGA monitor.

• Serial Port RS 232 available ( two serial ports available in
case of Ergometer control).

• Any Mouse and Printer compatible with the MS Windows™
operative system.

• PC conform to European Directive 89/336 EMC

List of parameters calculated
FVC - Forced Vital Capacity
Symbols um Parameter

FVC l Forced Vital Capacity

Best FVC l Best Forced Vital Capacity

FEV1 l Volume exhaled after 1s of the FVC

PEF l/s Peak Expiratory Flow

PIF l/s Peak Inspiratory Flow

Vmax 25% l/s Expiratory flow at 25% of FVC

Vmax 50% l/s Expiratory flow at 50% of FVC

Vmax 75% l/s Expiratory flow at 75% of FVC

FEF25-75% l/s Average expiratory flow between 25% and 75% of
FVC

FEV1/FVC% % FEV1/FVC x 100

FET 100 % s Forced expiration time (100% FV)

VEXT ml Extrapolated Volume (back extrapolation)

VC- IVC Slow Vital Capacity and Ventilatory pattern
Symbols um Parameter

EVC l  Expiratory Vital Capacity

IVC l  Inspiratory Vital Capacity

ERV l Expiratory Reserve Volume

IRV l Inspiratory Reserve Volume

IC l Inspiratory Capacity

VE l/m Expiratory Minute ventilation

Vt l Tidal Volume

Rf resp/min Respiratory frequency

Te s Duration of expiratory

Ti s Duration of inspiratory
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Ttot sec Duration of Total breathing cycle

Vt/ti l/s Vt/ti ratio

Ti/Ttot l Ti/Ttot

MVV- Maximum Voluntary Ventilation
Symbols um Parameter

MVV l/m Maximum Voluntary Ventilation

Bronchoprovocation Response
Symbol UM Parameter

FallFEV1 % Fall in FEV1  from baseline or post diluent

Fall Vmax50% % Fall in Vmax  from baseline or post diluent

P10 % Provocative dose (or concentrat.) causing FEV1 to
fall 10% baseline

P15 % Provocative dose (or concentrat.)  causing FEV1 to
fall 15% baseline

P20 % Provocative dose (or concentrat.)  causing FEV1 to
fall 20% baseline

Pony graphic archive
The pony graphic archive can store data from tests conducted on

over 200 patients. Its actual capacity depends on the width (vol-
ume axis) of the flow volume loops stored: the flatter the loops,

the greater the number of tests that can be stored.

Pony graphic assigns a progressive number to each new chart

(i.e. paper archive), in which all the data and test results relative

to the new patient are stored. The Pony graphic also assigns an
ID Code number for each patient.

For each patient’s ID code, the best FVC, VC, IVC, MVV and

Post FVC tests can be stored.

The criteria to choose the best tests are:

FVC the greatest summation value FVC + FEV1

VC the greatest VC value

IVC the greatest IVC value

MVV the greatest MVV value.

The parameters calculated during the entire test session are

grouped in two categories:

LAST data and loop of the last test executed

BEST data and loop of the best test executed.
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These data are stored until you enter data on a new patient with
New command.

For each patient, only the group of parameters calculated based

on the best tests, is transferred to the archive memory by means
of the key Enter as soon as the execution test is completed.

Notice: all the stored data are saved even when the Pony

graphic is turned off (power switch off) so long as the Ni-Cd

batteries are sufficiently charged.

Archive structure
Patient’s ID Code
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List of commands
Pony graphic is provided with a multifuction keyboard, whose
keys have different meanings in relation to the kind of executing

function.

Function Keys
The main function/keys list is the following.

Key Function

New inserts anthropometric data and ID Code of a new

patient.

Sex modification of the sex value in the anthropometric

data.

Patient displays and modifies the last inserted patient’s data.

Utility accesses the utility menu.

Print prints out patient’s data or test.

FVC carries out the Forced Vital Capacity test.

VC carries out the Slow Vital Capacity test.

MVV carries out the Maximum Voluntary Ventilation test.

Last displays the last test.

Best displays the best test.

Paper advancing roll of printer paper.

Confirm and cancel commands
The following commands are active during every Pony graphic

functions:

Key Function

Cancel cancels the last operation

Enter confirms the operation in progress

Utility menu
Some commands, like the utility and configuration commands,
allow to access other functions.

Pressing the utility key , the keyboard is structured as follows:
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Key Function

Post test selects a reference Pre test for the

execution of the post tests.

Test list printouts or displays the patients’

contents of the archive.

Test search searches for an archived test to dis-

play or print out of the test data or

loops.

Transmit Data allows the data transferring to a PC

or modem.

Erase Archive allows to erase all data of the ar-
chive.

Configure displays the utility menu.

Configure Menu
Pressing the configuration key, the key board is structured as

follows:

Key Function

Calibrate F/V allows the turbine calibration .

Predicted values allows the predicted value selection.

Diagnosis allows to disable or enable the auto-
matic diagnosis.

Units allows the selection of the unity of

measurement.

BTPS allows to calculate the BTPS factor
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Setting up thePony graphic
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Preparing the unit
Before using the Pony graphic it's necessary:

• set up the turbine Flow Meter

• check the paper in the printer

• check the ribbon in the printer

• make sure the batteries are charged

Turbine
To install the turbine:

1. Connect the turbine flow meter to the Main Unit,  by inserting

the 4-pin turbine Flow Meter plug in the slotted jack.

2. Insert the disposable mouthpiece on the turbine flow. Use the

proper mouthpiece adapter for children.

optoelectronic reader
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paediatric mouthpiece

Adaptor

turbine flowmeter

Turbine connection

adults mouthpiece
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Internal Printer
To replace the printer ribbon
1. Remove the printer cover.

2. Press the ribbon cartridge down where it says Push.

3. Insert the new ribbon cartridge.

4. Replace the printer cover introducing the paper roll in the

opening on the printer front.

To replace  the printer paper
1. Remove the printer cover.

2. Remove the empty roll.

3. Turn on the system until the message “select a function"

appears on the screen.

4. Insert the roll of paper through the opening towards the rear

of the printer.

5. Press the paper key to advance the roll of paper.

6. Replace the printer cover.
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printer ribbon

printer cover
printer paper

Press and pushthe cover forward



Pony graphic 32

Power Supply
The Pony graphic can be supplied by the following ways:

• NI- Cd recharging batteries.

• Connection to 110-220v plug by the proper batteries charger-
power supply.

• Connection to the “car lighter ”plug.

If  the Pony graphic is used when it is connected to the main the

recharging time will be longer.

Once the batteries are fully charged, they allow the execution of

about 200 tests.

When the batteries reaches a lower level, the Pony graphic shows

it with the "Battery" sign on the screen. In this case you can still

use the unit but it's suggested to recharge the batteries.

220V Power supply

Adaptor for car

Connection to the "car lighterplug"

Connection to the net
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Notice: In case of complete battery discharge, the Pony graphic

will lose all data

To charge the batteries
1. Connect the batteries charger or the lighter adapter to a power

supply connector.

2. Connect the batteries charger to a socket, as it is specified on
the batteries charge itself and check that the “charge “ indica-

tor  is on.

Maximum recharging time is 1 hour and 30 minutes and if the

batteries are not fully discharged the time is shorter. Leaving the

batteries charger connected longer than the maximum charging
time not damage will occur.

Notice: It's suggested not to use the pony graphic during the

first minutes of charging.

When the green led indicator of the charger batteries is flashing,

the batteries are charged.

battery charge led indicator
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Using thePony graphic
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Turning the Pony graphic on
After having connected the turbine Flow Meter, checked if there
is any paper and ribbon in the printer, turn the Pony graphic on:

1. Set the power switch on “I” and the display should show
information about the tests in archive, the free memory and

the message “insert date”.

2. Confirm or modify the date on the display pressing the keys
corresponding to the number to type. For example if you

want to insert the date “ 12.- 07- 1994 “ it is necessary to type

sequential the keys 1, 2, 0, 7, 9 ,4 and press Enter to confirm.

3. Once the date is confirmed with Enter, the main pattern ap-

pears on the display.
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Configuring the Pony graphic
The Pony graphic allows the user to configure the following fea-
tures:

• Predicted values.

• Automatic diagnosis.

• Unit of measurement.

Accessing to the Configuration Menu
1. Turn the system on, confirm or modify the date and press

Enter .

2. Press the Utility key.

3. Select Configure by pressing the key 6 .

Predicted values
It is possible to select 6 predicted values, they are:

1. ERS 93

2. ITS White

3. ITS Black

4. Knudson 83

5. Multicèntrico Barcelona

6. LAM

To select the predicted values
1. On the Configure menu press the key 2
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2. Press the key corresponding to the selected predicted value.

Notice: Before modifying the configuration of the predicted val-

ues, check if the software is able to read the predicted values.
Otherwise the patient’s predicted values in the Pony graphic's

archive won’t correspond with the ones on the PC.

Units of measurement
It is possible to select two units of measurement .

Unit decimal metric English

Weight kg Pound

Height cm inches

Selecting the unit of measurement

1.On the Configure menu press the 4 key

2. Press the key corresponding to the selected unit of measure-

ment.

Notice: Modifying the unit of measurement the data in the ar-

chive will be erased.
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Printer
Pony graphic besides to print on its own printer allows to print a

wide printout report with loops and data to an external printer.
The external printout is compatible only with printers with HP

PCL3 printer language equipped with a serial input RS232.

Print out report characteristics
The report is printed on a single sheet of 297x210 mm (A4 stand-

ard size).

The flow/volume and volume/time loops are printed according to
ATS 1987 Hand-Measurement standards.

To connect Pony graphic  to the external printer
1. Turn the Pony graphic on.

2. Connect the serial adapter 9-25 pin to the serial cable.

3. Connect the 9 pin connector in the Pony graphic plug and the
25 pin connector in the printer serial plug.

To select the printing mode
1. On the Configure menu press key 5 .

2. Press the key corresponding to the printer chose.
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Notice :The program maintains the configuration even after

turning the unit off.

To print with the external printer
1. Set the unit for external printing and press Print  key.

2. Press Enter to confirm or DEL to cancel the task.

Notice: The external printer setting enables the printing of a

complete report, all the other printouts, tests list, cannot be
transferred and will continue to be printed with the internal

printer.

Calculating the BTPS factor
Ambient conditions values are used to calculate the BTPS factor
to which all the measured volumes and flows are corrected.

BTPS Body Temperature Saturated Ambient Pressure

ATPS Ambient Temperature Saturated Ambient Pressure

PB Barometric Pressure (mmHg)

PH20 Partial Pressure of water vapour (mmHg)

T Temperature at the flowmeter (C°)

TA Ambient Temperature (C°)

The BTPS factor is calculated as follows:

V(BTPS)=V(ATPS)*[(273+37)/(273+T)]*[(PB-PH20)/(PB-47)];

LOG(PH20)=8.10765-1750.286/(235+TA).

PH20(KPa)=1.63---0.07*T+0.0053*T^2 (ERS 1993)
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BTPS inspiratory correction
1. Turn the system on and press the Utility Key.

2. Select Configure by pressing the key 6 .

3. Press 6  corresponding to the BTPS choice.

4. Type on the data pattern the PB, TA, RH values and press
Enter key twice.

BTPS expiratory correction
1. Turn the system on and press the Utility Key.

2. Select Configure by pressing the key 6 .

3. Press 6  corresponding to the BTPS choice.

4. Press Enter key three times and choose 1 for enable and 2 for

disable the expiratory correction.
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Entering data
Before executing tests the Pony graphic must have certain infor-
mation on the patient to be tested, which will be inserted in the

relative chart.

The table below shows admissible values for the above param-

eters.

Parameter min max um keyboard operation

Id Code 1000 9999 -- type the keys corre-

sponding to the
number

sex F M -- press the key sex to
modify the sex

Age 3 100 years type the keys corre-
sponding to the age

Height 50 230 cm type the keys corre-
sponding to the height

Weight 5 200 kg type the keys corre-
sponding to the weight

Eth.corr. 50 150 % type the key corre-
sponding to the %

The Ethnic correction value allows to increase or decrease pre-
dicted values according to the patient characteristics.

Typing for example the value “105”, it indicates an increase of
5%. The value “95” indicates a decrease of 5% of the predicted

values.

In case of loss of patient’s data , it won’t be possible to carry out
tests and the Pony graphic will display the message: Insert pa-

tient’s data.

New Patient
Before executing tests, except for the Post FVC test, it is neces-

sary to insert the patient’s data.

To insert patient’s data
1. Turn the pony graphic on and confirm or modify the date.
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2. The message “ Select a function” appears on the display,
press the New key twice ( the second time to confirm the

selection).

3. Type the new ID code or confirm the automatic ID code and
input the patient’s data.

In case the code has been already used, the message “ already in

use” will appear on the display, press any key and start inputting

the patient’s data again.

Press the Enter key to confirm each value.

To switch between Male and Female press Sex.

At any time it is possible to cancel the value inserted, if it has not

been confirmed. To do this press Cancel and type the new value.

To modify patient’s data
The unit allows to edit the patient’s data, only before having con-

firmed any test executed by the patient.

1. Press Patient, the patient’s data window will appear.

2. Press the Enter key until you reach the value to be edited.

3. Type the new value and confirm by pressing Enter.

4. Confirm or modify all the other values to save the changes.

Notice: When you choose the Post FVC test it is not possible to

modify the patient’s data; pressing the Patient key you will ob-

tain the display of the data themselves.
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Test storing
The pony graphic stores the best test of every test.

If a patient executes more FVC; MVC; VC; or IVC tests during the

same examination, the Pony graphic will always store the best test
for any kind of test.

When the bronchial provocation test is executed, the stored data
will be:

• The best pre FVC (Loop and parameter).

• Every post FVC test (loop and parameter).
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Performing spirometric Tests
Once inserted patient’s data, the selection of tests to be executed
starts.

The pony graphic allows the execution of the following exams:

Key Exam

FVC Forced Vital capacity.

VC Slow capacity ( Expiratory or inspiratory) and respira-
tory pattern.

MVV Maximum voluntary ventilation.

In case of the FVC test, other two tests can be executed by the

patient: the Pre and Post bronchial stimulation.

W hen the test is over, it is possible to print out the Best test (Best

key) and the last executed test (Last key).

The Pony graphic assigns a maximum time for the execution of

the test, after which the test is interrupted, even if has not fin-

ished yet.

If you want to interrupt the test in advance, press the Stop key.

Forced Vital Capacity
This test provides important information about the resistance of

the airways.

FVC test manoeuvre
1. Breathe normally several times (optional).

2. Execute a maximum inspiration.

3. Execute a maximum forced expiration.

4. Execute a maximum forced inspiration 8 (optional).

5. Breath normally.
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Parameters calculated
During the FVC test the following parameters are calculated :

Parameter um Parameter name

FVC 1 Forced vital capacity

FEV1 1 Volume exhaled after 1 m’’

PEF 1/s Peak Expiratory flow

PIF 1/s Peak Inspiratory flow

Vmax 25% 1/s Expiratory flow at 25 % of FVC

Vmax 50% 1/s Expiratory flow at 50% of FVC

Vmax 70% 1/s Expiratory flow at 75 % of FVC

FEF 25- 75% 1/s Average Expiratory Flow between 25% and 75% of
FVC

FEV1/FVC% % 100x FEV1/ FVC

FEV/VC% % 100x FEV1/VC

FET100% s Forced Expiration Time

To carry out the FVC test
1. Connect the patient to the turbine flow meter.

2. Apply the nose clamp to the patient and check if the mouth-

piece is properly set.

3. When the message “ select a function “ appears press FVC

key and start the test.

Notice: The respiration must start only after having pressed the

FVC test and do not wait longer than 5 seconds, otherwise the

program will return to the Main Menu.
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To Interrupt the test
The examination is interrupted when:

1. Pressing the Stop key.

2. In case of the flow absence, after 5 seconds confirming and

erasing the test.

Confirming or cancelling the test
At the end, the test will be confirmed pressing the Enter key or

erased pressing the 1  key.

Results
The Pony graphic stores the best executed test. However it is pos-

sible to display data and loops of the last executed test (Last key)

and of the best test (Best key) by means of the corresponding keys.

The Last and Best functions are active until the new patient’s

data are inserted.

It is possible to display and print out the results of the tests in the

following ways:

Option Operation

Displaying the parameters press several times the Enter key to

read the obtained results.

Printing out press the Print key.

Slow Vital Capacity
The Slow Vital Capacity (VC) is the maximum amount of air that

can be expirated after a maximum inspiration condition.

The Slow Inspiratory Vital Capacity is the maximum amount of

air that can be inspired after a maximum expiration condition.
The Pony graphic recognises automatically during the execution

of the test whether it is a VC or a IVC.

VC test manoeuvre
1. Breath normally for several times (optional).

2. Execute a maximum inspiration.

3. Execute a slow maximum expiration.

4. Breathe normally (optional).
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IVC test manoeuvre
1. Breathe normally several times (optional).

2. Execute a maximum expiration.

3. Execute a slow maximum inspiration.

4. Breath normally (optional).
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Parameters calculated
Parameter um parameter names

VC 1 Slow Expiratory Vital Capacity

IVC 1 Slow Inspiratory Vital Capacity

ERV 1 Expiratory Reserve Volume

VE 1/m Minute Ventilation

Rf resp/ m Respiratory Frequency

t, E s Average expiratory time during rest respiration

t, I s Average inspiratory time during rest respiration

VT 1 Tidal Volume

VT/t,1 1/s Tidal volume /average inspiratory time

t,I/tot 1 Average inspiratory time (average inspiratory time
+ average expiratory time)

To carry out the VC test
1. Connect the patient to the turbine flow meter.

2. Apply the nose clamps and check if the mouth piece is prop-

erly set.

3. At the request “ Select a function “ and press the VC key and

start the test.
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Notice: The respiration must start, after having pressed the VC

key and do not wait longer than 5 seconds, otherwise the pro-
gram will return to the Main Menu.

To calculate the parameters of the Respiratory Pattern, make the

patient breathe for 3 sufficiently regular consecutive respiration

acts.

To interrupt the test
The examination is interrupted when:

1. Pressing the Stop key.

2. In case of flow absence, after 5 seconds.

3. In any case after 45 seconds after the beginning of the test.

Confirming and erasing the test
At the end of the test, the test will be confirmed pressing the
Enter key or erased pressing the Cancel key.

Results
The Pony graphic always stores the best test executed during the
tests. However it is possible to display or print out the data and

the loops of the last test (Last key) and of the best test (Best key)

by means of the corresponding keys.

The Last and Best functions are active until the new patient’s

data are inserted. After having confirmed the test with Enter, on
the display the results are shown.

To print out the test press the Print key.

Maximum Voluntary Ventilation
The maximum voluntary respiration is the maximum volume that

can be breathed in 1 minute. The measure is executed in 12 sec-

onds (ATS) and extrapolated at once.

MVV Test manoeuvre
Have the patient breathe deeply at a rate of 30 breaths/m'.
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Parameters calculated
Parameter um parameter name

MVV 1/m’ Maximum Voluntary Ventilation

To carry out  the MVV test
1. Connect the patient to the turbine flow meter.

2. Apply the nose clamps and check if the mouth piece is prop-

erly set.

3. At the request “Select a function “ press the MVV key and

start the test.

Notice: The Respiration must start after having pressed the

MVV key and do not wait longer than 5 seconds, otherwise the
program return to the Main menu.

To interrupt the test
To end the test before 12 seconds, press the Stop key or interrupt

the test and wait 5 seconds.

Confirming or erasing the test
At the end of the test, the test will be confirmed pressing the key

Enter or erased pressing the Cancel key.

Results
The Pony graphic always stores the best test executed during the

tests.



Pony graphic 52

However it is possible to display or to print out the data and the
loops of the last test (Last key) and of the best (Best key) by

means of the corresponding keys.

The Last and Best function are active until the new patient’s data
are inserted. At the end of the test, on the display results are

shown.

To print out the test press the Print key.

Bronchial Provocation Test
The Pony graphic allows the execution of the FVC Test before
and after ( PRE and POST ) bronchial stimulation.

The values of the POST FVC tests are compared with the corre-
sponding PRE values.

To carry out the Post FVC test
1.  At the request “select a function“, press the Utility key.

2. Select “Post test” pressing the 1 key.

3. At the request “Insert a code“ type the ID Code of the patient

4. Confirm with Enter and check that the message “ Kind of test
Post” and the ID code appear on the display .

5. Press the FVC key.

6. At the request “Insert the quantity of bronchial drug”, type

the amount of the drug administration and confirm with En-

ter.

7. Execute the FVC test.

At the end the test will be confirmed pressing the Enter key or

erased pressing the 1  key.
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To execute several Post FVC tests and to store the best one, after
each administration, press FVC and confirm without typing the

amount of the bronchial drug. Every time the quantity of bron-

chial drug is administered, the Pony starts the next “step “ and
the best test is stored.

The PRE and POST flow -volume loops are shown superimposed

on one another for a better comparison.

Notice: The quantity of drug must be a whole 5 digit number

between 0 and 65535.

To carry out a bronchial provocation test and analyse how the

airways react to the drug in several steps:

1. Once the first administration test has been confirmed, at the
request “ Select a function “ press the FVC key.

2. At the request “Insert the quantity of bronchial drug “ type
the value of the addition of the data of the first administration

and the second one.

3. Execute the FVC test.

4. Repeat the above operations for the number of the Post tests

executed.

Notice: The dose administered during the POST FVC execution

must be a cumulative dose ( The last dose + The addition of the
previous doses ); since the Pony doesn’t add up the value typed

in the previous phases.

Response to the drug
To analyse the response of the airways to the administered drug
and to calculate the fall of the FEV1, during the administration of

the different doses:

1. At the end of the Post test, before executing the follow-

ing one, select “Response” pressing the 2 key.

On the display the test and the Post tests list appear. The dis-
played fields are:

FEV1 FEV1 in absolute value.

FVC FVC in absolute value.

FF1% Percentage of the fall of the FEV1 in relation to the
Pre value.

Dose Cumulative dose of the drug.
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In this way it is possible to check the decrease of the FEV1 during

the Post phases and to stop the test when the FEV1 reaches a

significant value.

To interrupt the test
The test is interrupted:

1. Pressing the Stop key.

2. In case of flow absence, after 5 seconds.

Results
After having confirmed the test with Enter, the Pre and Post

loops are displayed.

Option Operation

Displaying the parameters press the Enter key several times to

read the obtained results.

Printing out press the Print key.



Chapter 3 Using the Pony graphic 55

ATS reproducibility
The ATS recommendations (see the Appendix chapter) show that

the test is in agreement with the ATS reproducibility criteria
(1987) if 2 tests out of at least 3 executed by the same patient

differ in the FVC and FEV1 values of a quantity smaller than the

5% or 100 ml ( if the 5% was larger than 100 ml ).

If this criteria is met, the system displays: “ATS reproducibility”

message, followed by the relative parameters ( FVC, FEV1 or
both ).
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Other Functions
The Pony graphic provides other functions to make the manage-
ment of the archive easier, whether for the search of the data or

for their transmission to a PC.

Utility Menu
The Utility Command pools many functions to increase the Pony

graphic potential.

These functions are:

Key Function

Post Test allows the execution of a bronchial-

provocation test.

List allows to display and print out the

list of the tests in archive.

Search test allows the search of a test in archive

to display and print out the loops and

data .

Transmit allows the transmission of the ar-

chived data on the Pony to a PC.

Erase Archive allows to erase the data in archive

Configure accesses to the Configuration Menu

of the System.

Accessing to the Utility Menu
• After having confirmed the date at the request “ Select a

function", press the Utility key.

Tests list
The system allows to display or print out information about the

tests stored in the memory. To choose which test retrieve from
the memory it is suggested first to get a complete list of the con-

tents of the archive.
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To display the list in the archive
1. After having turned the Pony graphic on and confirmed

the date, press the Utility key

2. Press key 2 .

3. Press the Enter key to obtain the complete list in the archive,

otherwise type the code to get the list of tests that belong to it.

The parameters in the list are:

• Progressive number of the test.

• Number of the patient’s ID code.

• Patient’s sex.

• Patient’s age.

• Date of test execution.

The list is displayed on 10 lines pages; to display the following

lists press the Enter key.

If in the archive no test is present, on the display the following

message will appear: "Empty Archive".

Printing the list
• To obtain the complete list or a partial one press the Print

key.

Search Test
The Pony graphic provides a new function to search a test stored

in the archive. In this way it is possible to consult an examination

whether on the display or on printout without downloading data
on a PC
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To search a test in the archive
1. Turn the Pony graphic on, confirm the date and press the

Utility key.

2. Select“Search test”.

3. Insert the ID code or the test number you want to examine

and confirm pressing Enter .

4. Press 1 to display the test or 2 to print it out.

Data transmission
The pony graphic allows to transmit the data archived on the PC

hard disk by means of a serial cable “ RS 232 “

For this operation, follows instructions described in the chapter
concerning software.

Link to the PC
• Connect the RS232 supplied cable as it is described in the

following figure.
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To prepare the Pony graphic to transmit data to PC
1. Turn the Pony on.

2. On the Utility menu select Download by pressing key 4 .

3. Press twice Enter to transmit all the test in the archive other-

wise select tests by typing the appropriate test numbers.

Notice: The selection is relative to the numbers of the tests.

Before executing the selection it is advisable to print out the list
of the tests in the archive.

To prepare the PC for reception
1. Choose Receive from the Test menu.

2. Into the "Receiving Test" dialogue window press the Receive
button to prepare the software.
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To start the transmission
1. To start the transmission press 7 .

2. The software shows a bar indicating the transmission in
progress.

Notice: For further operation on PC, consult the chapter 4.
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Erasing data
The Pony graphic memory has a capacity of 100 tests circa. When

the message "Memory Full appears it is suggested to download
all data to PC and than erase all tests stored to leave the memory

for new tests.

Notice: By choosing “ Erase archive “, all data stored in the

Pony graphic archive, will be erased.

If you want to save the tests into a permanent memory, before
erasing them, you can transfer them to a PC as it has just de-

scribed in the previous paragraph.

To erase file
1. Turn the Pony graphic on and press the Utility key.

2. Select the function Erase archive pressing the 5  key.

3. Confirm the command typing sequentially the keys “369”.

4. Check if the message “archive erased” is shown and the

message “Request new ID code” appears on the display.

5. Confirm the ID code (code: 1000) or insert a new start code

pressing Enter .
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Data management
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Setting up the Pony graphic

Preparing Pony graphic
Before using the Pony graphic it is necessary:
• Set up the turbine flowmeter.

• Insert the batteries placing them as indicated on the back of

the instrument.

• Link the instrument to your PC throw the serial port available

(COM1 or COM2).

Installation of the PC software
From the Windows Program Manager menu bar:

1. Use the mouse or keyboard to select File.

2. Select Run  from the File menu.

3. In the Command line box, type a:\install (assuming the disk
is in drive A:)

4. Click on OK (or press ENTER key).

The program will load up a dialog box and ask for a directory to

be installed in. We recommend Ponywin for the exported files
and the program. After the program has finished installing, it will

present a message indicating that the installation was successful;

click on end.

To actually use the program, you need only to open the Program

Group (Ponywin) and double-click on the Ponywin icon.
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Configuring the program

Test option
Before using the software it is suggested to set the options in the

Configure dialog  window from the Option  menu.

Serial port
You must select the serial port that will be used to connect the

Pony graphic with the PC.

To select the serial port:

1. Select RS-232

2. Click on COM 1 or COM 2 button (the selected port must be
different from the mouse one).

Units of measurements

It is possible to configure the units of measurements for weight

and height both for printing and viewing.

To select the units of measurements:

• Click on cm/Kg  or in/lb according to the desired format.
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User free fields
The Patient’s database is mainly made of 3 cards (Patient card,

Visit Card and Test card.) where it is possible to store the infor-

mation about the patient and the visits .

Even though the information that can be typed as a standard is a

lot, it is however possible to customize some fields (user free
fields) labelling them with the desired name (insurance #, social

security #...).

The customizable fields are:

• 3 fields in the Patient Card (Patient’s information)

• 3 fields in the Visit Card (information about the visits)

• 3 fields (2 numeric) in the Test card( information about Test)

To customize the fields:

• In the group User free fields type the desired text in the 9

fields available.

Graphs
All the graphs visualized and/or printed can customized in colors

and appearance.

To customize the graphs:

1. Select the group Graphs

2. Select the desired colors of the curves ( 5 curves max can be

overlapped on the same graph).

3. Enable or disable the Grid option.
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The Automatic Diagnosis

Pony graphic has a function to calculate the automatic diagnosis.
The algorithm has been carried out referring to international

scientific literature mentioned in the bibliography paragraph of

the appendix chapter.

The automatic diagnosis is calculated at the end of the FVC Test

if:

• The automatic diagnosis option is enabled.

• The patient’s anthropometric data allow the calculation of the

LNN (Lower Limit of Normal range).

• At least one FVC test has been carried out.

To enable/disable the Automatic Diagnosis
• Click on the Enable button of the group Spirometry to en-

able the calculation and the visualization of the automatic

interpretation.
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Quality control
Pony graphic allows a quality  test control. The calculation has

been carried out referring to international scientific literature

mentioned in the bibliography paragraph of the appendix chap-
ter. The messages concerning the quality control are shown at the

end of the test execution.

• Enable/disable the quality control.

Ambient conditions

Ambient conditions value are used to calculate the BTPS factor

to which all the measured volumes and flows are corrected.

BTPS Body Temperature Saturated Ambient Pressure

ATPS Ambient Temperature Saturated Ambient Pressure

PB Barometric Pressure (mmHg)

PH20 Partial Pressure of water vapor (mmHg)

T Temperature at the flowmeter (C°)

TA Ambient Temperature (C°)

V(BTPS)=V(ATPS)*[(273+37)/(273+T)]*[(PB-PH20)/(PB-47)];

LOG(PH20)=8.10765-1750.286/(235+TA).

PH20(KPa)=1.63---0.07*T+0.0053*T^2 (ERS 1993)

To insert the ambient conditions values
1. Select Ambient conditions from the Option menu and type

the values in the corresponding fields.



Chapter 4 - Data management 69

Parameters manager

The program allows to calculate a huge number of parameters; it

is advisable, in order to simplify the analysis of the results, to

view, to print and to order the only desired parameters.

1. Select the menu Options/Parameters manager

View: Move the parameters to view in the Parameters se-
lected list.

Print: Move the parameters to print in the Parameters se-

lected list.
Order: Drag the parameter up or down through the mouse.

Customize: Insert, modify and delete the custom parameters.

Predicteds manager
The program contains a preset of predicteds, but the user is al-

lowed to customize its own predicted sets.

1. Select  Options /Predicteds manager.

The Predicteds manager window is divided into two forms:

Predicteds set and Formula definition.
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Predicteds set
This form allows the user to manage the set of predicteds. The
following information define a set:

Name: Identify the set and cannot be duplicated;

Description: free field;

Age: the adult predicteds start since this age.

• To insert a new set of predicteds click on the New button.

The field Name must be filled and must be unique. To stop
without saving click on the Cancel button.

• To delete a set of predicteds click on the Delete button. If a
set is deleted, also the associated formulae are deleted.

• It is possible to generate a new set of predicteds with the

same attributes and the same formulae of the selected one. To
do this click on the Copy... button and specify a new Name.

• To import a set of predicteds click on the Import... button and
select a file of Predicteds files type.

• To export a set of predicteds click on the Export... button.

• In the list Set current predicteds choose the current predicteds

for printing and viewing.

Set the current predicted
Pony graphic allows to calculate the predicted values according

to 4 configurable sets:
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ERS 93 Zapletal

Knudson83 Knudson83

ITS white ITS white

ITS black ITS black

LAM LAM

MC Barcellona MC Barcellona

• Select the desired choice in the group Predicted.

Formula definition

This form allows the user to manage the formulae associated to a
set of predicteds.

1. Select the set of predicteds to manager from the list
Predicteds set.

2. To insert a new parameter click on the New... button.

3. The parameter formulae can be:

• calculated according to the predicteds in the list Use the

predicteds formulae;
• or customized by the user with the option ...or the custom-

ized formulae.

4 The button Copy stores the selected parameter in memory.

5 The button Paste inserts a new parameter from the one cop-

ied. If the name is not unique, the user is asked whether to
specify a new name or to replace the existing parameter.



72 Pony graphic graphic -User’s Manual

Archive path
This program allows to work with different archive path; you can

for instance use a path as C:\PONYGRAPHICW20\1995 to
manage tests performed during 1995 and

C:\PONYGRAPHICW20\1996 during 1996.

To select a different directory
1. Select Archive Path from the Option menu

2. Select the desired directory.

3. Enable the LAN (Local Area Network) support if you want

to share the archive with other user or you are accessing to
other shared archives, indicating your User Name.

Uploading data from the spirometer

Before starting any analysis you must upload the data from the
spirometer via the serial port.

1. Link up the spirometer to the PC with the RS232 cable sup-
plied.

2. Select Receive from the Test menu or press the button by side.

3. Prepare the spirometer to transmit the data.

4. Click the Receive button on PC.

5. Start data transmission from the spirometer.

Linking tests to a Patient in the archive
The data received from the spirometer are held in temporary

memory. These tests must then be stored within the patient data-
base by linking each test to the corresponding patient.
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To link a test to a  patient
1.Selct Link from the Test menu or press the button by side.

2.Select the test you want to link in the top area of the window.

3. Select the correspondent Patient in the bottom area of the win-

dow.

Buttons description relative to the test  link area:

Move to the first test to link

Move to the previous test to link

Move to the next test to link

Move to the last test to link

Delete current test

Compare the paper report of the spirometer

Buttons description relative to the patient card area:

Find a patient in the archive by the Archive Navigator

Find a patient in the archive with the same ID Code of

the current test to link.

Visualize the spirometer print report

Link the current test to the current patient.



74 Pony graphic graphic -User’s Manual

Link automatically all the tests creating, if

necessary, a new patient card with the same ID

Code of the test.
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Managing the Patient’s database
The Patients database is mainly composed by : the Patient Card,

the Visit Card and the Test card.

Patient Card
Contains all the information relative to the Patient that remain the

same during the different visits (first name, last name, date of

birth...); it is created the first time that the Patient come to be
tested and it is recalled during the following visits. Each Patient

is related to only one Patient Card.

Buttons  description:

Move to the first Patient in the archive

Move to the previous Patient in the archive

Move to the next Patient in the archive

Move to the last patient in the archive

Find a patient in the archive

Delete current patient from the archive

Edit current patient card
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Visit Card
Contains all the information relative to the visit (diagnosis, visit

description...) and those one related to the patient that can change

between different visits (height, weight, smoke...). Each Patient
can be related to several Visit Cards but it is not possible to cre-

ate two different Visit Cards during the same day. Before carry-

ing out any spirometric test it is necessary to create a new Visit
Card or to open the today’s Visit Card.

Buttons  description:

Move to the first visit in the archive

Move to the previous visit in the archive

Move to the next visit in the archive

Move to the last visit in the archive

Find a visit in the archive

Delete current visit from the archive

Edit current visit card

NOTE: several features of the program are enabled only if there

is an “Active Patient”; the name of the active patient is shown on

the status bar.

Test card
Contains all the information about the test.

Delete current test from the archive.

Edit current test

To import/export a Tets card
This function allows to import /export a test card  with the re-

spective  visit and patient card.

1. Select the patient and press the key by side.

2. Choose the test and press OK . All data will be imported/

exported in the XPO file format.
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Viewing results
All the visualization functions refer to the test carried out by the

active patient, whose name is indicated on the left-side of the
status bar.

To view the results of a test proceed as follows:

1. Select the Archive Navigator from the File menu

2. Select the patient corresponding to the test you want to view

3. Select in the list box of the tests up to 5 tests of the kind
(FVC, VC/ivc, or MVV) and press OK.

To switch between graph and or data use the following buttons
on the toolbar:

view  Flow Volume graph

view Volume Time graph

view data of the test

view bronchial provocation response

If you need more than one visualization meantime use the New

Window function from the Window menu.

Deleting a test from the archive
1. Select Archive navigator from the File menu  or press the but-

ton by side.

2. Select the test that you want to eliminate from the list of the

tests referred to the active patient and press the button by side.
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Managing the optional databases

Diagnosis Database
The program allows to manage a diagnosis database, whose

records are composed by a diagnosis ID code and a string of text.

The report of the visits can be done either typing the desired text

in the field “Diagnosis” of the Visit Card or, more quickly, re-
trieving from the diagnosis database the desired one.

If you want to insert, modify or delete a diagnosis from the data-
base select Database Diagnosis... from the File menu.
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Printing results
You can print out in two different ways:

• printing the Report

• printing the Active Window

Printing the report
The standard Report is composed by 2 or 3 pages depending if

you wish to printout the bronchoprovocation response.

The 1st page contains the F/V and V/t curves of the best Forced

Vital Capacity, the patient data, the notes and the diagnosis.

The 2nd page contains the numerical results of the all test FVC,

VC/IVC and MVV carried out in the current visit.

The third page is the bronchoprovocation response.

1. Select Print Report  from the File menu.

2. Select the desired option among:

FVC graph: print the F/V and V/T curves of the best FVC test

Response: print the bronchoprovocation response

FVC post Tests: print curves and data of the FVC post test.

Printing the active window
This printout function is only enabled when the active window

(title bar highlighted) is one of the following objects:

• Any kind of Graph.

• Numeric data

• List of visit.

To print the active window
1. Ensure that the active window is one of the preceding objects.

2. Select Print Active window from File menu.

Data exporting
With this function you can export the test in 3 formats:

•  Lotus 1,2,3
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•  Excel

• ASCII (Text File)

• XPO (Cosmed file format)

To export data
1. Select Export tests from the File menu

2. Select the test to export from the list box and press OK.

3. Type the name and the format of the file in the dialog Save

as.

Nota: if the ASCII format is selected, the Text button in the dialog

box Save as allows you to configure the separators for character
based files.
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Page setup

Select Page Setup... from the File menu

Header
All the printouts carried out by the program are preceded by 3

rows of customizable header (usually contain the name and the

address of the Hospital using the spirometer).

Data
Patient and visit informations are printed below the header.

These data are reported on 3 columns and 5 rows, and is possible
to configure the disposition of the voices or avoid to print those

that don't interest.

Margin
Configures the print margins from the borders of the paper. The

unit of measure is decided in Units of measurements.

Footer
Insert the physician name.
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Other features of the program
The software allows to manage  files selecting Archive from the

File menu.

Archive
Initialising the database
It deletes all file stored by the software:

Select Initialize.

Reorganizing the archive
In order to free space on the hard disk and/or to correct possible

errors present within the database:

Select Reorganize.

Backup

It is strongly recommended to backup files periodically.

On the Backup dialog box set the different options, selecting the

destination path with the Browse key or pressing New to create a
new directory.

Press OK to confirm.
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Restore

On the Restore dialog box specify source path and press OK,  a
dialog box  will appear indicating all data of the backup pro-

cessed.
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Calibration
The system is precisely calibrated by Cosmed and will remain so
as long as it is used properly. If a proper maintenance is executed

it is possible to check the calibration of the Flow meter turbine

even after long periods.

You may check the calibration by measuring a known volume

(syringe) using the FVC and VC tests and comparing the results
measured with the predicted one (the syringe one). If the discrep-

ancy is more than 3% the system should be re calibrated.

This standard calibrated syringe (3 Litres) is supplied by
COSMED:

Calibration syringe: P/N 00600-01-11
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Calibrating flows and volume
1. Turn the Pony graphic on and confirm or change the date.

2. Disable the expiratory correction following the instruction
written in the "Calculating the BTPS factor" paragraph.

3. At the request “Select a function” execute a FVC or a VC test,

using the calibrated syringe in order to obtain a comparison
between the volume of the Turbine Flow meter and the sy-

ringe one. If the volume is the same you should not calibrate

the system, vice versa execute as it is described below.

4. Access to the Utility menu pressing the Utility menu.

5. Press the 6 key to open the Configure menu.

6. Press the 1 key and insert:

• The value measured in cl
• The predicted value in cl (300 if you are checking the sys-

tem with a 3- litres syringe)

7. Press the Enter key obtaining the Flow/Volume correction.

8. To store the new correction type 369 and press Enter to con-

firm.

9. Enable the expiratory correction following the instruction

written in the"Calculating the BTPS factor" paragraph.

The calibration is indicated by a message and the print out of new

correction Flow /Volume result.

Notice: We advice you to maintain the print out of the new

correction F/V result, since, in case the Pony could lose the data
for a batteries discharge, such value will be requested. If such

value had been lost execute the system calibration again .

The calibration F/V= 100 value correspond to no correction.
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The sistem maintenance
All service operations which are not specified in this handbook
should be performed by qualified personnel in accordance with

the service handbook (to be required to the manufacturer).

Prior to the device cleaning, disinfection and ispection it is neces-

sary to switch off the device itself and to disconnect adapters

from the supply mains.

Cleaning and disinfection instructions are of fundamental impor-

tance to control infections and assure patient safety. In fact aspi-

ration of residue, particulates and contaminates are life – threat-
ening.

In this handbook is recommended to follow the rules worked out
by ATS and ERS (see: ”Lung Volume Equipment and Infection

Control” – ERS/ATS WORKSHOP REPORT SERIES, European

Respiratory Journal 1997; 10: 1928 – 1932), which are summa-
rised and adapted for COSMED products in the following part:

• Accessible internal as well as external surfaces of equipment
exposed to expirates should be washed and disinfected prior

to testing of subsequent patients.

• Disinfection should ideally be performed by heat sterilization,
but gas or liquid sterilization can be used if the equipment is

well cleaned first (no droplets of saliva/sputum remain).

• Disposable gloves should be worn when handling mouth-

pieces, when cleaning equipment exposed to saliva or sputum

and especially when drawing blood.

• Laboratory staff should wash hands prior to testing of each

patient.

• Adopt particular precautions when testing patients with rec-

ognised high – risk communicable diseases (e.g. tubercolosis,

multidrug – resistant staphylococcus). In these cases, the
clinical need for such testing should justify the risks.

During disinfection:

• do not use alcohol or other liquids containing gluteraldehyde

on the exterior surfaces of the equipment. Actually they can

damage polycarbonates plastics and may produce unealthy
substances.
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• do not use abrasive powders or glass cleaners containing
alcohol or ammonia on the plexiglas components of the

equipment

• do not steam autoclave any parts of the equipment unless it is
clearly specified.

• do not immerse the optoelectronic reader.

The mouthpieces are single use not sterilized accessories. It is

highly recommended to follow the suggestions given in the hand-
book concerning the general rules for infection control in lung

tests.

In order to ensure maximum precision in measurements, we ad-
vise you to disinfect the system periodically.

As disinfecting solution it is suggested Sodium hypoclhorite 5%
(bleach).

To disinfect the turbine, pour one litres of water and add the

disinfecting solution. The disinfection procedure is easy and can
be effected every time it will be necessary, keeping attention to

some precautions.

To clean the turbine
The following is the disinfection procedure you should follow:

1. Disassemble the Turbine Flow meter as described in the fig-
ure below.

2. Dip it in a disinfecting solution for about 2 hours.

3. Rinse it in a container filled with clean water and shaking

gently until it is clean (do not clean the Turbine by putting it

under running water!)

4. Let it dry to the air

Notice: Do not expose the Turbine or any part of the system to

high heat and do not put it under running water!

After having cleaned the Turbine, check if the Turbine propeller

rotates freely even with a low speed air  flow.

At the end reassemble the Turbine as it is described in the figure

below.
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Inspections
The equipment needs easy inspections to be carried out in order

to assure a proper electrical and mechanical safety level in the
years.

These inspections are highly recommended after a rough use of

the equipment or after a period of storage in unfavourable envi-
ronmental conditions.

Referring to the electrical safety, is important to control the con-
ditions of insulation materials of cables, plugs and of any other

visible part by means of simple inspection, when the equipment

is switched off and adapters (or electrical feeders) are discon-
nected from the supply mains.

Mechanical parts to be checked are essentially the turbine flowm-
eter and the breathing circuits. Follow these instructions:

· extract the turbine flowmeter form the optoelectronic reader;

· verify, by inspection, that the turbine axis fits correctly in its

seats and the blade is strongly fastened on the axis itself (it

can be useful to shake slightly the turbine in order to note any
anomalous movement).

Control if there are torn or broken components in the breathing

circuits: remember  that they can create safety risk to patients
during tests.
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Troubleshooting
It is possible to solve some problems of the system directly, with-
out contacting your nearest technical assistance. If you need a

further help consult the information of the following paragraph.

The printer is locked
• Check the paper is not jammed.

• Check the batteries charge.

The Pony points out a memory lost
If the batteries are discharged, the Pony graphic loses some or all

the stored data. Therefore insert the predicted data to re configure
the system ( ID code, F/V factor, predicted values, automatic

diagnosis , unit of measurement ).

During the execution the loop doesn’t appear
• Check the Turbine connector is connected properly

• Check the Turbine is deeply inserted in the optoelectronic

reader

• Blowing in the Turbine, check it rotates freely, otherwise

clean it as it is described in the previous paragraph.

Batteries are not being charged
• Check if the green led down on the left is on

• Check if there is current in  the power  plug

• Check that the batteries charger connector is inserted properly

• Before connecting the battery charger, make sure you are

using the proper voltage and frequency

The Pony does not transmit the data to the PC
• Make sure the serial port RS 232 selected for the transmission

is configured properly with the Software.

• Check the serial cable connectors are inserted properly.

The external printer doesn’t print
• Check  the cable is the RS232  provided by Cosmed and

make sure it is correctly connected.
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• Check the printer uses the HP PCL3 or following printing lan-
guage.

• Check on the manual printer  that its communication protocol

is the following:

Bit number 8

Parity None

Speed 9600 Baud

Bit Stop 2

Error messages
The Pony graphic points out if the system is not working prop-
erly, by means of the following displayed message:

Two can be the likely problems:Problem Solution
Printer failure Remove the printer cover and make

sure the paper is inserted properly.

Batteries discharged Charge the Pony graphic batteries.

Printer error Check if the external printer has

been set up properly.
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Assistance, Warranty
If you can not solve the problems independently, contact Cosmed
or your nearest technical assistance centre.

Returning the system for service
In case you should send the system for repair, send it directly to
the following address:

COSMED S.r.l.

Via dei Piani di Monte Savello 37

P.O. Box 3
00040 Pavona di Albano - Rome Italy

tel. +39-06-93.25.492

fax +39-06-93.14.580

email: customersupport@cosmed .it

To ensure that you receive efficient technical assistance, please
specify as precisely as possible the nature of the problem as it is

specified on the assistance information form.

We advise you to save the original packing box. You may need it

if it is necessary to ship it to a technical assistance centre.

Warranty
The system is provided with a 12 months warranty, starting from

the purchasing date . It covers failures happened during normal

use of the system, due to provable faults of the components or to
manufacture.

Exclusions
The following components are excluded from warranty:

• Parts subject to consume

• Fragile parts of glass or plastic

• The batteries, the rechargeable batteries

• Damages of the paintings

• Damages due to a not proper use of the system or failure to

observe the manual instructions.
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In case the warranty is expired, send besides the system, the copy
of a document (such a bill of lading or invoice), which prove the

purchase date.

The transport must be executed in free port and it will be re-
shipped charges collect. In case of transport damages this costs

will be charged to the buyer.

Information form for assistance
Fill a photocopy of the form and send it with the system.

If not, the repair can not be effected.
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Information form for assistance
Client ........................................................................... Date................................................

Address..................................................................................................................................

City............................................................................... zip ..................................................

tel .................................................................................. fax ..................................................

Vat number...........................................................................................................................

System

Model ..............................................................S/N..............................................................

Purchase date..................................................(enclose the bill of lading or invoice)

Maintenance contract n°: ................... (if there is one)

Before sending the system, make sure you have executed the procedures of the para-

graph “ Problem solving “properly. Do not send superfluous accessories for assist-
ance (manuals, consumables etc.).

List of the sent parts
................................................................................................................................................

................................................................................................................................................

................................................................................................................................................

Trouble description
................................................................................................................................................

................................................................................................................................................

................................................................................................................................................

................................................................................................................................................

Is the failure intermittent? yes ❐ not ❐

When the system is delivered, enclose any evident printout.

Delivering instructions
................................................................................................................................................

................................................................................................................................................

................................................................................................................................................
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ATS 94 recommendations
Reference: “Standardization of Spirometry: 1994 Update” “Ameri-
can J. Respiratory Critical Care Medicine”, Vol. 152, 1107-1136;

1995:

ATS recommendations
Range Volume: 8l (BTPS)

Range Flow: ±14 l/sec

Accuracy Volume: ± 3% or < 50 ml

Accuracy Flow: ± 5% or < 200 ml/s

Flow resistance: < 1.5 cmH
2
O at 14 l/s

Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC val-

ues should be within 5% or 150 ml.

The end of test: no change in volume for 1 second with at least 6
seconds of collected volume

Accumulation time: the maximum time allowed for volume accu-
mulation during the VC manoeuvre should be at least 30 seconds

and at least 15 seconds during the FVC.

The spirometer should be store at least 8 FVC manoeuvres FEV1
should be calculated by using the “back extrapolation” method to

detect the start of the test, extrapolated volume must not be

higher then 5% FVC or 150ml.
Volume: 10 mm/l

Flow: 5 mm/l/sec

Time: 20 mm/sec
F/V Ratio: 2:1

The total number of error (FVC e FEV1 >±3.5%, FEF25-75%
>5.5%) during the measurement of the 24 standard  waveforms

must be lower than 4. Features F/V e V/t.
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Predicted values
Here are the formula to calculate the predicted values.

Generality
In the following formula are respected these conventions:

Ht Height in cm

Wt Weight in kg

BSA Body Surface Area cm2

Age Age in year

SD Standard Deviation

The formula of the Body Surface Area :

BSA(m2)(71.84* x Wt 0.425* x Ht0.725)/1000

The software allows the calculation of the Predicted values ac-
cording to the following forms:

ERS 93
Reference Adult:
Standardized Lung Function Testing: Official Statement of the

European Respiratory Society, The European Respiratory Journal

Volume 6, Supplement 16, March 1993.

Reference Paediatric:
Compilation of reference values for lung function measurements

in children: Ph.H. Quanjer, J. Stocks, G. Polgar, M. Wise, J.
Karlberg, G.Borsboom, ERJ 1989, 2, Supp.4, 184s-261s.

Males (>18 years )Symbol Formula SD
IVC 0.061*H-0.028*A-4.65 0.56

FVC 0.0576*H-0.026*A-4.34 0.61

TLC 0.0799*H-7.08 0.7
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RV 0.0131*H+0.022*A-1.23 0.41

FRC 0.0234*H+0.009*A-1.09 0.6

RV/TLC 0.39*A+13.96 5.46

FRC/TLC 0.21*A+43.8 6.74

FEV1 0.043*H-0.029*A-2.49 0.51

FEV1/FVC -0.18*A+87.21 7.17

FEV1/VC -0.18*A+87.21 7.17

FEF25%-75% 0.0194*H-0.043*A+2.7 1.04

Vmax25% 0.0546*H-0.029*A-0.47 1.71

Vmax50% 0.0379*H-0.031*A-0.35 1.32

Vmax75% 0.0261*H-0.026*A-1.34 0.78

PEF 0.0614*H-0.043*A+0.15 1.21

MVV 1.19*H-0.816*A-37.95

ERV Pred FRC-PredRV

VC Pred IVC 0.56

Females (>18 years )Symbol Formula SD
IVC 0.0466*H-0.026*A-3.28 0.42

FVC 0.0443*H-0.026*A-2.89 0.43

TLC 0.066*H-5.79 0.6

RV 0.0181*H+0.016*A-2 0.35

FRC 0.0224*H+0.001*A-1 0.5

RV/TLC 0.34*A+18.96 5.83

FRC/TLC 0.16*A+45.1 5.93

FEV1 0.0395*H-0.025*A-2.6 0.38

FEV1/FVC -0.19*A+89.1 6.51

FEV1/VC -0.19*A+89.1 6.51

FEF25%-75% 0.0125*H-0.034*A+2.92 0.85

Vmax25% 0.0322*H-0.025*A+1.6 1.35

Vmax50% 0.0245*H-0.025*A+1.16 1.1

Vmax75% 0.0105*H-0.025*A+1.11 0.69

PEF 0.055*H-0.03*A-1.11 0.9

MVV 0.842*H-0.685*A-4.87

ERV PredFRC-PredRV

VC Pred  IVC 0.42



Chapter 5 Appendix 99

Males (<18 years )Symbol Formula SD
IVC 7.9942-0.12509*H+0.000605*H^2 0.393

FVC PredIVC0.393

TLC 15.1397-0.22713*H+0.001002*H^2

RV -1.052+0.012*H

FRC 9.372-0.1415*H+0.000602*H^2 0.35

RV/TLC 34.7-0.0647*H 3.91

FRC/TLC 38.73+0.0615*H 4

FEV1 6.6314-0.10261*H+0.000499*H^2 0.523

FEV1/FVC 84.47 4.55

FEV1/VC 84.47 4.55

Vmax25% -6.822+0.07811*H

Vmax50% -4.5848+0.0543*H

Vmax75% -2.3069+0.02817*H

PEF -6.9865+0.0806*H

VC PredFVC

Females (< 18 years)Symbol Formula SD
IVC PredFVC 0.263

FVC 0.169-0.01217*H+0.000189*H^2 0.263

TLC 1.7592-0.03394*H+0.0003*H^2

RV -0.805+0.0109*H

FRC 0.02556*H-2.1778 0.26

RV/TLC 34.7-0.0647*H 3.91

FRC/TLC 38.73+0.0615*H 4

FEV1 0.0364*H-3.0378 0.42

FEV1/FVC 84.47 4.55

FEV1/VC 84.47 4.55

Vmax25% 0.06367*H-5.1934

Vmax50% 0.04477*H-3.3655

Vmax75% 0.02483*H-1.8576

PEF 0.06594*H-5.3794

VC PredFVC 0.263



Pony graphic 100

KNUDSON 83
Reference Adult/Paediatric
Changes in the Normal Maximal Expiratory Flow-Volume Curve
with Growth and Anging: J. Knudson, D. Lebowitz, J. Holdberg,

B. Burrows; ARRD 1983; 127:725-734

Note : SD@FEV1/FVC and FEV1/VC from ERS93

Males (> 25 years)Symbol Formula SD
IVC PredFVC 1.183

FVC -8.7818+0.0844*H-0.0298*A 1.183

FEV1 -6.5147+0.0665*H-0.0292*A 1.017

FEV1/FVC PredFEV1/PredFVC*100 6.51

FEV1/VC PredFEV1/PredVC*100 6.51

FEF25%-75% -4.5175+0.0579*H-0.0363*A 1.422

Vmax50% -5.5409+0.0684*H-0.0366*A 1.624

Vmax75% -2.4827+0.031*H-0.023*A 0.884

MVV PredFEV1*40

VC PredFVC 1.183

Females (> 20 years)Symbol Formula SD
IVC PredFVC 0.721

FVC -2.9001+0.0427*H-0.0174*A 0.721

FEV1 -1.405+0.0309*H-0.0201*A 0.65

FEV1/FVC PredFEV1/PredFVC*100 6.51

FEV1/VC PredFEV1/PredVC*100 6.51

FEF25%-75% 1.1277+0.0209*H-0.0344*A 1.131

Vmax50% 0.6088+0.0268*H-0.0289*A 1.178

Vmax75% 1.1177+0.0096*H-0.0259*A 0.848

MVV PredFEV1*40

VC PredFVC 0.721
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Males (< 25 years)Symbol Formula SD
IVC PredFVC 1.048

FVC -6.8865+0.059*H+0.0739*A 1.048

FEV1 -6.1181+0.0519*H+0.0636*A 0.932

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% -6.199+0.0539*H+0.0749*A 1.315

Vmax50% -6.3851+0.0543*H+0.115*A 1.504

Vmax75% -4.2421+0.0397*H 0.89

MVV PredFEV1*40

VC PredFVC 1.048

Females (< 20 years)Symbol Formula SD
IVC PredFVC 0.716

FVC -4.447+0.0416*H+0.0699*A 0.716

FEV1 -3.7622+0.0351*H+0.0694*A 0.622

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% -2.8007+0.0279*H+0.1275*A 1.01

Vmax50% -2.304+0.0288*H+0.1111*A 1.074

Vmax75% 0.024*H-4.4+0.2925*A-0.0075*A^2 0.763

MVV PredFEV1*40

VC PredFVC 0.716

ITS White
Reference Adult/Paediatric
Intermountain Thoracic Society

Note: SD@FEV1/FVC and FEV1/VC from ERS93

Males (>19years)Symbol Formula SD
IVC PredFVC 0.57

FVC -4.65+0.06*H-0.0214*A 0.57
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FEV1 -2.19+0.0414*H-0.0244*A 0.43

FEV1/FVC 110.49-0.13*H-0.152*A 4.23

FEV1/VC PredFEV1/FVC 4.23

FEF25%-75% -2.133+0.038*H-0.0204*A 0.85

Vmax25% 0.088*H-0.035*A-5.62

Vmax50% 0.0684*H-0.0366*A-5.54

Vmax75% 0.031*H-0.023*A-2.48

PEF 0.094*H-0.035*A-5.99

MVV 1.34*H-1.26*A-21.4 28.97

VC PredFVC 0.57

PIF 1.19*BSA-0.023*A+3.09

Females (> 19 years)Symbol Formula SD
IVC PredFVC 0.35

FVC -3.59+0.0491*H-0.0216*A 0.35

FEV1 -1.578+0.0342*H-0.0255*A 0.29

FEV1/FVC 126.58-0.202*H-0.252*A 4.7

FEV1/VC PredFEV1/FVC 4.7

FEF25%-75% 2.683+0.0154*H-0.046*A 0.69

Vmax25% 0.043*H+0.025*A-0.13

Vmax50% 0.0321*H-0.024*A-0.44

Vmax75% 0.0174*H-0.025*A-0.18

MVV 0.807*H-0.57*A-5.5 10.71

VC PredFVC 0.35

PIF 1.15*BSA-0.014*A+2.73

Males (< 18 years)Symbol Formula SD
IVC PredFVC 1.048

FVC 0.000358*H^3.18/1000 1.048

FEV1 0.000774*H^3/1000 0.932

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% 0.000798*H^2.46/60 0.13
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Vmax25% 0.07*H+0.147*A-7.05

Vmax50% 0.0543*H+0.115*A-6.39

Vmax75% 0.0397*H-0.0057*A-4.24

PEF 0.078*H+0.166*A-8.06

MVV PredFEV1*40

VC PredFVC 1.048

PIF 2.57*BSA+0.17*A-2.27

Females (< 18 years)Symbol Formula SD
IVC PredFVC 0.716

FVC 0.00257*H^2.76/1000 0.716

FEV1 0.00379*H^2.68/1000 0.622

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% 0.00379*H^2.18/60 0.14

Vmax25% 0.044*H+0.144*A-3.37

Vmax50% 0.0288*H+0.1111*A-2.3

Vmax75% 0.0243*H+0.2923*A-0.0075*A^2-4.4

PEF 0.049*H+0.157*A-3.92

MVV PredFEV1*40

VC PredFVC 0.716

PIF 0.06*H-5.26

ITS Black
Reference Adult/Pediatric
Intermountain Thoracic Society

Note: SD@FEV1/FVC and FEV1/VC from ERS93

Males (>19 years)Symbol Formula SD
IVC PredFVC 0.57

FVC -4.65+0.06*H-0.0214*A 0.57

FEV1 -2.19+0.0414*H-0.0244*A 0.43
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FEV1/FVC 110.49-0.13*H-0.152*A 4.23

FEV1/VC PredFEV1/FVC 4.23

FEF25%-75% -2.133+0.038*H-0.0204*A 0.85

Vmax25% 0.088*H-0.035*A-5.62

Vmax50% 0.0684*H-0.0366*A-5.54

Vmax75% 0.031*H-0.023*A-2.48

PEF 0.094*H-0.035*A-5.99

MVV 1.34*H-1.26*A-21.4 28.97

VC PredFVC 0.57

PIF 1.19*BSA-0.023*A+3.09

Females (>19 years)Symbol Formula SD
IVC PredFVC 0.35

FVC -3.59+0.0491*H-0.0216*A 0.35

FEV1 -1.578+0.0342*H-0.0255*A 0.29

FEV1/FVC 126.58-0.202*H-0.252*A 4.7

FEV1/VC PredFEV1/FVC 4.7

FEF25%-75% 2.683+0.0154*H-0.046*A 0.69

Vmax25% 0.043*H+0.025*A-0.13

Vmax50% 0.0321*H-0.024*A-0.44

Vmax75% 0.0174*H-0.025*A-0.18

MVV 0.807*H-0.57*A-5.5 10.71

VC PredFVC 0.35

PIF 1.15*BSA-0.014*A+2.73

Males (< 18 years)Symbol Formula SD
IVC PredFVC 1.048

FVC 0.00107*H^2.93/1000 1.048

FEV1 0.00103*H^2.92/1000 0.932

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% 0.000361*H^2.6/60 0.18

Vmax25% 0.07*H+0.147*A-7.05
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Vmax50% 0.0543*H+0.115*A-6.39

Vmax75% 0.0397*H-0.0057*A-4.24

PEF 0.078*H+0.166*A-8.06

MVV PredFEV1*40

VC PredFVC 1.048

PIF 2.57*BSA+0.17*A-2.27

Females (< 18 years)Symbol Formula SD
IVC PredFVC 0.076

FVC 0.000834*H^2.98/1000 0.076

FEV1 0.00114*H^2.89/1000 0.622

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

FEF25%-75% 0.00145*H^2.34/60

Vmax25% 0.044*H+0.144*A-3.37

Vmax50% 0.0288*H+0.1111*A-2.3

Vmax75% 0.0243*H+0.2923*A-0.0075*A^2-4.4

PEF 0.049*H+0.157*A-3.92

MVV PredFEV1*40

VC PredFVC 0.076

PIF 0.06*H-5.26

Lam
Reference Adult/Pediatric
A survey of ventilatory capacity in Chinese subjects in Hong

Kong: Lam Kwok-Kwong, Pang Shing et Al. Annals of Human
Biology, 1982, vol. 9, No. 5, 459-472.

Note : SD@FEV1/FVC and FEV1/VC from ERS93

Males (> 20 years)Symbol Formula SD
IVC PredFVC (H/100)^2*0.22

FVC (H/100)^2*(-0.013*A+1.912) (H/100)^2*0.22

FEV1/FVC PredFEV1/PredFVC*100 4.23



Pony graphic 106

FEV1/VC PredFEV1/PredVC*100 4.23

PEF (0.86*A-0.00047*A^3+313.4)/60 0.84

MVV PredFEV1*40

VC PredFVC (H/100)^2*0.19

FEV1 (H/100)^2*(-0.016*A+1.823) (H/100)^2*0.19

Females (> 20 years)Symbol Formula SD
IVC PredFVC (H/100)^2*0.19

FVC (H/100)^2*(-0.01*A+1.518) (H/100)^2*0.19

FEV1 (H/100)^2*(-0.012*A+1.442) (H/100)^2*0.17

FEV1/FVC PredFEV1/PredFVC*100 4.7

FEV1/VC PredFEV1/PredVC*100 4.7

PEF (0.45*A-0.00032*A^3+259.7)/60 0.62

MVV PredFEV1*40

VC PredFVC (H/100)^2*0.19

Males (< 20 years)Symbol Formula SD
IVC PredFVC (H/100)^2*0.17

FVC (H/100)^2*(0.064*A+0.335) (H/100)^2*0.17

FEV1 (H/100)^2*(0.059*A+0.322) (H/100)^2*0.15

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

PEF (15.08*A-0.0075*A^3+75.5)/60 0.54

MVV PredFEV1*40

VC PredFVC (H/100)^2*0.17

Females (< 20 years)Symbol Formula SD
IVC PredFVC (H/100)^2*0.19

FVC (H/100)^2*(0.041*A+0.507) (H/100)^2*0.19

FEV1 (H/100)^2*(0.04*A+0.454) (H/100)^2*0.17

FEV1/FVC PredFEV1/PredFVC*100 4.55

FEV1/VC PredFEV1/PredVC*100 4.55

PEF (19.96*A-0.0209*A^3+33.8)/60 0.52

MVV PredFEV1*40

VC PredFVC (H/100)^2*0.19
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Multicèntrico di Barcelona
Adult/Pediatric
Spirometric reference values from a Mediterranean population: J.
Roca, J. Sanchis, A. Agusti-Vidal, F. Segarra, D. Navajas. R.

Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur. Physiopathol.

Respir. 1986, 22, 217-224.

Males (> 20 years)Symbol Formula SD
FVC 0.0678*Ht-0.0147*A-6.05 0.530

FEV1 0.0499*Ht-0.0211*A-3.84 0.444

FEV1/FVC% 85.58-0.1902*A 5.36

FEF25%-75% 0.0392*Ht-0.0430*A-1.16 1.000

PEF 0.0945*Ht-0.0209*A-5.77 1.470

Vmax75% 0.0190*Ht-0.0356*A-0.14 0.620

Vmax50% 0.0517*Ht-0.0397*A-2.40

Females (> 20 years)Symbol Formula SD
FVC 0.0454*Ht-0.0211*A-2.83 0.403

FEV1 0.0317*Ht-0.0250*A-1.23 0.307

FEV1/FVC% -0.224*A-0.1126*W+94.88 5.31

FEF25%-75% 0.0230*Ht-0.0456*A+1.11 0.680

PEF 0.0448*Ht-0.0304*A+0.35 1.040

Vmax75% 0.02*Ht*0.031*A*0.0062*W*0.21 0.405

Vmax50% 0.0242*Ht*0.0418*A*1.62 0.925

Males (< 20 years)Symbol Formula SD
FVC 0.02800*Ht+0.03451*W+0.05728*A-3.21

0.443

FEV1 0.02483*Ht+0.02266*W+0.07148*A-2.91

0.378

FEF25%-75% 0.038*Ht+0.140*A-4.33 0.796

PEF 0.075*Ht+0.275*A-9.08 1.073

Vmax75% 0.024*Ht+0.066*A-2.61 0.562

Vmax50% 0.017*Ht+0.157*A+0.029*W-2.17 0.811
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Females (< 20 years)Symbol Formula SD
FVC 0.03049*Ht+0.02220*W+0.03550*A-3.04 0.313

FEV1 0.02866*Ht+0.01713*W+0.02955*A-2.87 0.263

FEF25%-75% 0.046*Ht+0.051*A-4.30 0.651

PEF 0.073*Ht+0.134*A-7.57 0.831

Vmax75% 0.027*Ht+0.032*A-2.68 0.507

Vmax50% 0.046*Ht+0.067*A-4.17 0.669

Automatic diagnosis
Reference: “Lung Function Testing: selection of refence values

and interpretative strategies”, A.R.R.D., 144/ 1991:1202-1218.

LLN=Pred*0,8 (80% of the Pred.)

The AD is carried out at the end of the  FVC manoeuvre if:

1. The automatic diagnosis is enable.

2. The patient’s data allows the calculation of the LLN.

3. It has been carried out a FVC  PRE test.Interpretation message Criterion
Normal spirometry FVC and FEV1/FVC >LLN

Obstructive abnormality

Mild % Pred FEV1<100 and 70

Moderate % Pred FEV1<70 and 60

Moderately severe % Pred FEV1<60 and 50

Severe % Pred FEV1<50 and 34

Very severe % Pred FEV1<34

Restrictive abnormality

Mild FVC<LLN e % Pred FVC70

Moderate % Pred FVC<70 and 60

Moderately severe % Pred FVC<60 and 50

Severe % Pred FVC<50 and 34

Very severe % Pred FVC<34
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Quality Control Messages
Reference: Spirometry in the Lung Health Study: Methods and

Quality Control, ARRD 1991; 143:1215-1223.QC Message Criterion
Star faster VEXT >5% della FVC e >150ml

Blast out harder PEFT >120 msec

Avoid coughing 50% drop in the flow in first second

Blow out longer FET100% <6 sec

Blow out more air flow>0.2l/s within 20 ml of FVC

Blow out harder dPEF <10%

Take a deeper breath dFVC <200ml and 5% best FVC

Blow out faster dFEV1 <200ml and 5% best FEV1

That was a good test No errors

FVC reproducible At least 3 acceptable maneouvres.
The 2 largest FVC within 0.2l of

each other FVC

FEV1 reproducible At least 3 acceptable maeouvres.

The 2 largest FEV1 within 0.2l of

each other.

PEF reproducible The 2 largest PEF within 10 %

MVV time too short  MVV time less than 12 sec
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